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Students are graded on studio projects, bell work, written work, quizzes and a semester final.  The final is 10% of 
the student’s grade.  All art projects are grading with a scoring guide that incorporates the student’s motivation, 
understanding and participation into the grade.  All scoring guides are in this folder.  It is the student’s  
responsibility to read through the scoring guide before turning in their assignment.  If a student would like to 
know their current course grade they can check SIS or come see me before or after school (SIS is updated  
weekly).  Projects are to be turned in to the designated location and will be graded within two weeks.  
 ** If a student is absent they must come see me before or after school to see what they missed.   
 
Project Due Dates:  Due dates are created one week after the last day the project is worked on in class.  After 
that due date, students have the following week to turn the project in late for a 30% late deduction (I call this 
the red week).  After that the project is NO LONGER ELIGIBLE for grading. 
REDO’s:  You can only redo a project you turned in ON TIME. 
Extensions:  If you need an extension you must ask for it at least 2 days BEFORE the project is due.  Bring the 
scoring guide to my desk and I will write your extended due date at the top.  Verbal extensions are not valid. 

Design and Digital Media:  MS. PUGH 
 

Email:  stephanie.pugh@raypec.org    Phone:  816-892-1400 ex 2059 

  Artpugh.weebly.com 

Available for Extra Help between 7:00-7:20 am and 2:45-3:00 pm or by appointment 
 

Course Description:  This course explores the different types of art tools and processes that are used.  From drawing to 

sculpture, printmaking to ceramics; it is all looked at.  Students will explore ways to combine mediums to create expressive 
works that push the boundaries of art.   
 

PRE-REQUISITES:  Students must have completed a Principles of Art (Art 2) course or its equivalent and Fundamentals of 

Drawing or its equivalent. 
 

Goals/Objectives: 
One goal of this course is to introduce and expand on the different techniques of graphic design.  These mediums are  
combined to bring out creative and expressive ideas in a variety of ways.   Students will think critically of the commercial art we 
see and discuss important issues in the art world aesthetically.  The final goal is to facilitate other core class essentials such as 
writing, reading, math and science while expanding on ways to visually express and communicate ideas and emotions. 
 

Essential Understandings: 
 Students will be able to use the elements of art and principles of design to support the communication of an idea. 

 Students will be able to apply demonstrate informed decision-making. 

 Students will be able to engage with experimentation and/or risk taking. 

 Students will be able to create expressive/symbolic art using computer software. 

 Students will be able to critique, analyze and synthesize artwork. 
 

Grading:  All grading is aligned to the Ray-Pec district approved Grading System 

A 100-93% 

A- 92-90% 

B+ 89-88% 

B 87-83% 

B- 82-80% 

C+ 79-78% 

C 77-73% 

C- 72-70% 

D+ 69-68% 

D 67-63% 

D- 63-60% 

F 50-0% 
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Classroom Rules: 
1. There is LIMITED FOOD in the art classrooms.  You may only have drinks with lids. 

2. All students are required to bring a pencil and their art folder to class every day. 

3. Students are responsible for cleaning up and making sure all materials are put back. 

4. NO art materials may leave this room without being checked out. 

5. Respect others and respect the materials and resources in this room. 
Cell Phones are not to be used during class time.  No phones/headphones during the first 5 minutes 

or when teacher is instructing. 
 

 

Classroom Procedures: 
1. Students come to class and get out their art folder and a pencil. 

2. Everyday will begin with a bell ringer, students are to get started on that immediately. 

3. After handing in bell work, class will begin with teacher instruction. 

4. Students will then either participate in a teacher lead activity or work independently on assigned art 
projects. 

5. Clean up will be called 5 minutes prior to the bell ringing. 
 

Helpful Hints: 
Come to class prepared and choose ideas that interest you-not ideas that you think are the easiest.  Spend time on 
your project because it shows in the end.  Remember, you are not going to like every assignment, but you are able 
to complete every assignment.  Take your time; there is no reward for finishing early. 

Behavioral Expectations: 
Students must be inside the door before the tardy bell rings.  The first part of class will begin with a bell ringer  
assignment; instructions will be on the white screen.  Students should come in, get out their art folder and work 
quietly.    Tardy students will not be given extra time on the bell ringer assignment.  Inappropriate behavior will be 
dealt with on an individual basis in alignment with the rules and discipline of the Ray-Pec school District.  If  
necessary, a student seat may be relocated to help get them back on track.  Confiscated cell phones will be given to 
administration with an office referral. 
 

 

Scoring Scale for all projects 
 

 

4 My art skills are refined and polished. I can problem solve and envision the end result before I have begun. 
 I can assist others and help them critically think through a challenge. 

3 I have quality art skills. I can use them without help. I am capable and in control of those skills, and know what  
techniques to use in a given situation. 

2 Basic art skills are part of me as long as I have assistance along the way. I need guidance and support to finish.  
I know what to do, but need help. 

1 I participate in the process and understand the various techniques. I can only finish a project as long as others guide me through every 
step. 

IE Insufficient evidence:  Even with help, no understanding or skill demonstrated  
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Using the lap tops and creating a 
shared Google folder 

 

 Login into your assigned computer only, report any issues immediately.   

 If your laptop will not log you in check on the side of your laptop for the  

     wireless toggle switch.  It may be turned off.   If it says there is not enough      

     space, hold the power button down until it turns of (hard shut down) and     

     try again.  

 Log into your Google account and open up your Google drive.   

 Create a folder in your Google drive by clicking the red “create” button and 

then select the first option which is “folder”  

 Name your folder with your HourLastnameFirstnameDDM 

  Ex:    2PughStephDDM    

 You now need to share this, find the image and click on it  

 Type in Ms. Pugh’s emails (Stephanie.pugh@raypec.org) and make 

sure to click “can edit”.  Your folder is now shared with me.   

 Inside that folder, for each new assignment you will make a folder.   

  Ex:  Logo Design, Cover Design ect. (refer to scoring guide)  

 NOTHING on this drive is permanent.  You must always have back ups of 

your tiles for this class.  It is recommended that you keep your photos on your 

drive in a different folder and/or on a separate flash drive. 

 All laptops have a place to insert a common SD card.  It is recommended that 

you buy a card reader to use as well on the desktops ($10 at Walmart). 

 You may only use YOUR laptop number.  Failure to comply with this will  

     result in revoking your laptop rights, you will be assigned a desktop only. 

 Report any issues with your laptop at the beginning of class.  These may  

     include; missing keys, low battery life, or not starting up. 

 

LABELING ASSSIGNMENTS 

Each assignment jpeg should be labeled LastnameFirstnameTitleAssignment 

Please save the Photoshop file of the assignment as well, labeled  

LastnameFirstnameTitleAssignmentPS 
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Vocabulary 
 

Graphic Design:  ___________________________________________________ 

__________________________________________________________________ 

Design:    _________________________________________________________ 

__________________________________________________________________ 

Brain Storm:  ______________________________________________________ 

__________________________________________________________________ 

Negative Space:  ___________________________________________________ 

__________________________________________________________________ 

Counter Space:  ____________________________________________________ 

__________________________________________________________________ 

Typography:  ______________________________________________________ 

__________________________________________________________________ 

Serif:  ____________________________________________________________ 

__________________________________________________________________ 

               C.R.A.P. Method of Design 
Contrast:  ________________________________________________________ 

_________________________________________________________________ 

Repetition:  _______________________________________________________ 

__________________________________________________________________ 

Alignment:  _______________________________________________________ 

__________________________________________________________________ 

Proximity:  _______________________________________________________ 

__________________________________________________________________ 

 

Photoshop Basics 

 

Gradients:  ________________________________________________________ 

Magic Wand:  ______________________________________________________ 

Filter:  ____________________________________________________________ 

Pixel:  ____________________________________________________________ 

Swatch:  __________________________________________________________ 

Flatten Image:  _____________________________________________________ 

Thumbnail:  _______________________________________________________ 

Feather:  __________________________________________________________ 

Select:  ___________________________________________________________ 

Layer:  ___________________________________________________________ 

Palette:  ___________________________________________________________ 
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Vocabulary 

5 Design Basics 

 1. 

 2. 

 3. 

 4. 

 5. 

Typeface:  ________________________________________________________ 

_________________________________________________________________

Font:  ____________________________________________________________ 

__________________________________________________________________ 

Bold Type:  _______________________________________________________ 

__________________________________________________________________ 

Italic Type:  _______________________________________________________ 

__________________________________________________________________ 

Monochromatic:  ___________________________________________________ 

__________________________________________________________________ 

Analogous:  _______________________________________________________ 

__________________________________________________________________ 

Triadic: ______ ____________________________________________________ 

__________________________________________________________________ 

Complementary:  ___________________________________________________ 

__________________________________________________________________ 

Split Comp:  _______________________________________________________ 

__________________________________________________________________ 

Double Split Comp:_________________________________________________ 

__________________________________________________________________ 

Copyright:  ________________________________________________________ 

__________________________________________________________________ 

JPEG:  ___________________________________________________________ 

__________________________________________________________________ 

CMYK Color:  ____________________________________________________ 

__________________________________________________________________ 

RGB Color:  _______________________________________________________ 

_________________________________________________________________ 

Stippling:__________________________________________________________ 

_________________________________________________________________ 

Visual Weight:  _____________________________________________________ 

__________________________________________________________________ 

Wet on Wet:  _______________________________________________________ 

_________________________________________________________________ 
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Design and Digital Media:  Logo Manipulation Collage 

 

Summary:  Using logos as a basis for a design collage, students create a successful 

composition using pieces of designs and replacing colors.   

 

Key Idea:  Commercial Ar t is all about creating designs that car ry across a mes-

sage.  Many logos we see are so familiar that if only a piece of the logo is seen, it is still    

readable even if the original colors are replaced.   

 

Objectives:  Students will… 

1. Get a sheet of copy paper and a pencil. 

2. Tape it to a larger sheet of paper, hold the paper with your less dominant hand 

and close your eyes. 

3. Let your pencil scribble a continuous line, crisscrossing the page. Don't try to 

stay within the rectangle.  

4. Use the computer to find different common logos and use a light box or computer 

screen to trace them on your paper. 

5. Color you paper using a double layer of Prismacolor color pencils and replacing 

all original colors (but still consider color schemes!).  If a logo has a red and 

green color scheme, that is complementary so replace those colors with another 

complementary pair 

6. Adhere finished design to cover of art folder with spray glue. 

7. Paint three coats of gloss medium: each coat goes a different direction. 

8. Make sure each coat covers paper and journal cover. 

 

Missouri State Standards:  F1, F2, F3 

Gle’s:  Strand I 1A HS Level 1           Strand II 1D HS Level 2  Strand II 2C HS level 2 

 

Materials:  Copy paper, light box,  

internet, magazines, color pencils,  

spray glue, gel medium, pencil,  

pencil sharpener 

 

Resources:   Lesson plan, I 

nternet,  magazines 
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Manipulated Logo Collage 
Summative Scoring Guide  

64 points possible 
 

 
 
 

Project requirements and Key Concepts 
Directions followed and paid attention to demo.  4 3 2 1 IE  
Paper is prepped using lines and space. 4 3 2 1 IE  
Logo and Slogan quiz is completed.   4 3 2 1 IE  
Composition elements show a high level of understanding.  4 3 2 1 IE 
 
Space is thought out and negative space does not overpower. 4 3 2 1 IE  
Replacement colors show an understanding of contrast  
and color theories.  4 3 2 1 IE  
Logos are disguised enough to make the viewer have to spend time  
figuring them out.  4 3 2 1 IE  
 
An exact likeness of the logo is achieved by tracing.    4 3 2 1 IE  
Simplicity is understood and created by eliminating text.  4 3 2 1 IE  
 
Negative space is small and handled by completing coloring in that area.   4 3 2 1 IE  
.   
Presentation and Craftsmanship 
Project is glued to the front cover of the art folder.  No excess  
glue is showing.   4 3 2 1 IE  
Overall craftsmanship of the end product shows time was  
taken/mistakes were corrected.   4 3 2 1 IE  
 
 
Work habits of an Artist 
Productive no matter how many distractions occur 4 3 2 1 IE  
Double layer of color pencils was used.   4 3 2 1 IE  
Maintained consistent effort; didn’t rush to finish and paid  
attention to details 4 3 2 1 IE  
Project is turned in on time with name on the scoring guide and  
art folder inside cover.   4 3 2 1 IE  
 

Grade:     /64 
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A:_________________ 

B: _________________ 

C: _________________ 

D: _________________ 

E: _________________ 

F: _________________ 

G: _________________ 

H: _________________ 

I: __________________ 

J: __________________ 

K: __SKIP___________ 

L: _________________ 

M: _________________ 

N: _________________ 

O: _________________ 

P: _________________ 

Q: _________________ 

R: _________________ 

S: _________________ 

T: _________________ 

U: _________________ 

V: _________________ 

W: _________________ 

X: _________________ 

Y: _________________ 

Z: _________________ 
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Elements Quiz:  DO NOT LOOK BACK IN YOUR 

FOLDER, keep your eyes on this page! 

 
Look on the board for the answer options and write the letter of the Element de-

scribed below.   

 

_____ the area between and around objects 

_____ the degree of light and dark in a design 

_____ can be horizontal, vertical or diagonal,  

_____ the reflection of light through a prism 

_____ a closed line that can be geometric or organic 

_____ how something feels or looks like it feels  

_____ three-dimensional object that exhibits length, width, and depth  

 

Principles of Design 
 

Balance is a principle of design concerned with arranging the elements so that no one 

part of the work overpowers, or seems heavier than, any other part.  Artists speak of three 
types of balance: Symmetrical, Asymmetrical and Radial  
 

Emphasis is making an element or an object in a work stand out, such as light next to 

dark  
  

Proportion is how parts of a work relate to each other and to the whole  
 

Rhythm/Repetitions is the visual flow through a work of art, incorporating the repeti-

tion of elements  
 

Unity is the arrangement of elements and principles of art to create a feeling of complete-

ness or wholeness.  
 

Contrast is the difference in visual properties that makes an object or element distinguish-

able from other objects and the background.  
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Principles of Design Quiz:  Do not reference other pages in your folder! 

Using the options on the board, write the letter of the correct answer below: 

 

1. _____ distribution of the visual weight of objects, colors, texture, and space 

2. _____ feeling of harmony between all parts of the artwork creating a sense of completeness 

3. _____ using elements that are very different to make things stand out 

4. _____ created when one or more elements of design are used repeatedly to create a feeling of 

      organized movement 

5. _____ the part of the design that catches the viewer’s attention 

6. _____ the feeling of unity created when all parts (sizes, amounts, or number) relate well with    

      each other 
 

DESIGN CHALLENGE:  CROSS CONTOURS 
 

1. Use the provided drawing paper that is 11X14.   
2. Find a simple still life, you need to have at least 3 items in your still life.  You may use 

actual items or photographs of items from the internet.  Items may all be the same 
type of item but should vary in looks slightly at least.   

3. Read the passage on cross contour line drawings and look at the examples for inspi-
ration.   

4. Use a pencil to lightly sketch in the outline contours of your objects thinking about 
taking up as much space as you can.  Items may overlap, fall off the page and your 
format can be horizontal or vertical.  Remember to erase often and perfect your out-
lines.   

5. Using a fine line sharpie, go over your initial outlines and add in your cross contour 
lines.  Be precise and follow the contours of your objects.   

6. You decide if you want background information, it is not required.   
7. Erase all pencil lines when you are done.   
8. Sign the back in pencil.   
9. This challenge is given with three class periods to 

complete it.  If extra time is needed you will need to 
take the drawing home.   

10. Hand in your drawing with your folder.  Drawing 
should be placed in the folder where the scoring 
guide is.   
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Project requirements and Key Concepts 
 
Directions are ready fully and carefully.  4 3 2 1  
At least 3 items are used for the composition, only photographs or actual items are used. 4 3 2 1   
Initial drawing takes up a large amount of space creating a successful composition.   4 3 2 1 
Subjects are interesting and draw viewer in. 4 3 2 1   
 
Initial drawing of contours is done in pencil, with corrections made as the artist draws.  4 3 2 1   
Contour outlines show a close likeness to the original item.   4 3 2 1   
 
Initial contours are outlined in fine line sharpie.  4 3 2 1   
Cross contours are added in fine line sharpie.   4 3 2 1   
 
Cross contours follow the original contours. 4 3 2 1   
Cross contours fill the space, artist uses an amount that makes the drawing have weight. 4 3 2 1 
More contour lines are added for darker values. 4 3 2 1 
Overlapping shows correct depth perception, 4 3 2 1 
All pencil lines are erased when drawing is complete.  4 3 2 1   
 
Artist signed the back of the artwork in pencil.    4 3 2 1   
 

Presentation and Craftsmanship 
 
Completed artwork shows a successful design creation of the original still life.   4 3 2 1   
Overall craftsmanship of the end product shows time was taken/mistakes were corrected.  4 3 2 1   
Project is in good condition without bends, tears or stray marks. 4 3 2 1 
 

Work habits of an Artist 
 
Productive no matter how many distractions occur 4 3 2 1   
Instructions were carefully followed.   4 3 2 1   
Maintained consistent effort; didn’t rush to finish and paid attention to details 4 3 2 1   
Project is turned in on time.   4 3 2 1   
 

Grade:     /84 
 
 
 

 
 
 

DESIGN CHALLENGE:  CROSS CONTOURS 
Summative Scoring Guide  

4 My art skills are refined and polished. I can problem solve and envision the end result before I have begun. 
 I can assist others and help them critically think through a challenge. 

3 I have quality art skills. I can use them without help. I am capable and in control of those skills, and know what  
techniques to use in a given situation. 

2 Basic art skills are part of me as long as I have assistance along the way. I need guidance and support to finish.  
I know what to do, but need help. 

1 I participate in the process and understand the various techniques. I can only finish a project as long as others guide me through every 
step. 
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Cross contour lines are drawn lines which travel, as the name suggests, across the 

form. Cross contours may be horizontal or vertical, as on the right side of the example, or both. Often, in 

more complex forms, cross-contours will be drawn at varying angles. In this rather lumpy example, the grid 

of cross-contours looks a bit like the gridlines on a globe or a diagram of a Black Hole in space.  

Cross contours show the form but don’t actually exist when you look at the object.  As a designer you are 

adding them to create an object design map.    

You Tube Video:   

▶ 7:00https://www.youtube.com/watch?v=YiMmYQ52QgE 

https://www.youtube.com/watch?v=YiMmYQ52QgE
https://www.youtube.com/watch?v=YiMmYQ52QgE
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What are these logos? 

_________________________ 

_________________________ 

_________________________ 

_________________________ 

_________________________ 

Image Organizer:  Company Brainstorming 

Use this webbing chart to brainstorm ideas about your company.   

 

 

 

 

 

 

 

 Company #1 
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Negative Space Logo Creation 
 

The Project: Create a final logo for  a business, band, organization or  event.  Final logo should show    

efforts in graphic design to capture the audience and get across the importance and function of their     

chosen idea along with showing pleasing compositions and proximity placements. .   

 

The Plan: Learn about what makes logo’s successful and practice logo creation using images and      

negative space that is all original.    

 

We’ll learn about: Contrast, Repetition, Alignment, Proximity and how they are used in design.          

Typography importance and using negative/counter space along with imagery in text oriented designs.   

 

We’ll Use: Adobe Photoshop, Adobe illustrator  and good old fashion hand drawing.   

 

Process: 

1. Participate in the class discussion over logo design and negative space. 

2. Look at the logos in the everyday world and discuss what makes them so recognizable. 

3. Make up or find a business, event, band or organization to make a logo for. You must decide what you 

are advertising before you start your logo design. 

4. Complete the Image organizer for your chosen company in your art folder. 

5. Make at least 2 sketches in your art folder of possible logo designs that use negative space or counter 

space.   

6. Discuss with the teacher and decide on your best logo solution. 

7. Take a photo of or recreate the image of your logo in Photoshop.  All imagery must be hand drawn or 

only using a photograph as a point of departure.  If using an original photo, it must be altered in a graphic 

way with filtering or color change.   

8. Use Photoshop to add your text. 

9. Once a final design is complete save it as a JPEG in your 

google drive DDM shared Folder 

10. You will need to place the logos as well as any other im-

portant information about the company on: 

letterhead (8 ½ x 11”) 

envelope (9 ½ x 4 1/8”),  

business card (3 ½ x 2”).   
            All of the elements must flow as one unit. They should 

look like they belong together as a package. You may take 

apart your logo and use different pieces of it if you feel it 

would make your design better.  Use Photoshop only.    

11. Mount your final pieces on black paper. This should look 

as professional as possible- pretend you are bringing this  

display to your company so they can approve your final  

design. (If it is not good you don’t get paid!) 
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Design and Digital Media—Logo Creation—92 points possible 

4 My art skills are refined and polished. I can problem solve and envision the end result before I have begun. 

 I can assist others and help them critically think through a challenge. 

3 I have quality art skills. I can use them without help. I am capable and in control of those skills, and know what  

techniques to use in a given situation. 

2 Basic art skills are part of me as long as I have assistance along the way. I need guidance and support to finish.  

I know what to do, but need help. 

1 I participate in the process and understand the various techniques. I can only finish a project as long as others guide 

me through every step. 

IE Insufficient evidence 

 

Conscientious learner: Personal growth and participation 
Project shows a willingness to try and attempt a new concept 4 3 2 1 IE  
Original and challenging design that shows individual creativity 4 3 2 1 IE  
Positive; asks for help and uses constructive criticism from 
teacher and others to improve their work 4 3 2 1 IE  
Created preliminary sketches required for approval before working 4 3 2 1 IE  
       
Fulfills assignment; composition and design 
Company chose shows student interest and effort.   4 3 2 1 IE  
Logo designs incorporate the use of negative/counter space 4 3 2 1 IE  
Image placement blends in with the composition and text 4 3 2 1 IE  
Image and text are used as a team 4 3 2 1 IE  
All images are copyright free or hand drawn 4 3 2 1 IE  
Space is used in a creative and original way on each item 4 3 2 1 IE  
 
Fulfills assignment; executing the stationary items 
Stationary items all match and seem to be a set 4 3 2 1 IE  
Photoshop is used for basic added Elements 4 3 2 1 IE  
Letterhead has business information (address, website, ect) 4 3 2 1 IE  
Envelope is created with correct measurements  4 3 2 1 IE  
Envelope has return address of company and fake recipient  4 3 2 1 IE  
Business Card is created with correct measurements 4 3 2 1 IE  
 
Care and Presentation: Craftsmanship 
All three items are mounted on black paper 4 3 2 1 IE  
Mounting shows nice placement and craftsmanship 4 3 2 1 IE 
Finished product looks professional with nice craftsmanship 4 3 2 1 IE  
 
Work Habits 
If others around you are disruptive and non-productive  
are you still able to be productive?  4 3 2 1 IE  
Project and scoring guide turned in on the requested date 4 3 2 1 IE  
Artist Signature added to the work on the back 4 3 2 1 IE 
All Items are saved on the google drive properly. 4 3 2 1 IE  
    
 

Grade : _____________/92 
 

SAVE FILES in a folder labeled:  LOGO DESIGN 
Jpeg:  LastnameFirstnameTitleLogodesign 

Photoshop file:  LastnameFirstnameTitleLogodesignPS 
 

You should have separate files for the business card, sta-
tionary and envelope.   
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Sketch at least 2 ideas for a logo, one must make use of counter space 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Take notes over introductory Photoshop uses 

here: 
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Article #1 Apple logo designer dishes on history  
Even people who aren’t Apple fans recognize the company’s distinctive, iconic 

logo; it ranks up there with the Nike swoosh or NBC peacock. But most probably 

aren’t familiar with the story behind the design. First created in 1977, the Apple 

logo was the handiwork of Rob Janoff, an art director at advertising and public 

relations firm Regis McKenna. 

In a lengthy interview with Creative Bits’s Ivan Raszl, Janoff talks about the    

history behind his classic design, including dispelling many of the rumors around 

it, such as the significance of the apple’s bite.  

 

Says Janoff: 

Anyway, when I explain the real reason why I did the bite it’s kind of a let down. 

But I’ll tell you. I designed it with a bite for scale, so people get that it was an   

apple not a cherry. Also it was kind of iconic about taking a bite out of an apple. 

Something that everyone can experience.  Janoff also talks about how Steve Jobs 

liked the design, how the Apple logo has evolved over the years, and the keys to 

good logo design. 

For me, though, one of the things I think makes Apple’s logo so iconic is that it’s 

used sparingly. As I type this on my MacBook, an iPod and iPhone on the desk 

before me, the only Apple logo visible to my eyes is the small one in the top      

left-hand corner of my computer display. Apple doesn't beat you over the head 

with its logo, but it does use it effectively, and that's part of the reason it's so im-

printed upon our memory. 
 

Article #2:  Apple Logo History 
It was 1976 and Jobs has been spending time on a friend’s farm picking apples when he told Wozniak of 

his idea for the name of their fledgling I.T. company. Was picking apples the inspiration? Perhaps one fell 

on his head and knocked free this gem of creativity, a-la Sir Issac Newton? Perhaps he just wanted to be 

ahead of Atari in the phone book? Whatever the case, Wozniak was equally taken with the moniker and 

the name stuck. All they needed then was a logo. 

 
The first Apple Logo Design was by Ron Wayne, who also co-founded the company. It was rather elabo-

rate in comparison to its later incarnations; as it depicted Newton under the famous apple tree, deep in  

http://creativebits.org/interview/interview_rob_janoff_designer_apple_logo
http://en.wikipedia.org/wiki/Steve_Jobs
http://en.wikipedia.org/wiki/Steve_Wozniak
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contemplation. Steve Jobs felt it was a little too intellectual, and that the details 

were hard to distinguish. For those reasons it was only used on the Apple I. 

 
In 1977 a second attempt at Apple logo design was undertaken by art designer 

Rob Janoff. The logo design was very simple- an apple with a bite taken out of it, 

adorned with all the colors of the rainbow, albeit in the wrong order. The sym-

bolism here was genius; the bite symbolized knowledge, as in the Garden of 

Eden, and was also a play on words, as in computer “byte”. The colors suggested 

vibrancy and energy, but the wrong ordering of these colors suggested a break 

from the establishment- freedom, daring and enterprise, sentiments most befit-

ting such a revolutionary technology. As Jean Louis Gassee put it, “You couldn’t 

dream of a more appropriate logo: lust, knowledge, hope and anarchy”. 

 
The Apple logo design remained unchanged until 1997 when Steve Jobs decided 

to change from the multi-colored look to a solid colored logo design. This was 

simply fitting with the more minimalist fashion of the time, and perhaps to her-

ald in a new era with the new millennium. 

The only obstacle faced by the Apple Logo being cemented in popular cultures 

collective consciousness has been ongoing legal scuffles with Apple Records. 

Both founders knew when they came up with the name, that it would only be a 

matter of time before Apple Records voiced concern. In 1981 an agreement was 

reached allowing Apple Computer to use the name provided they didn’t use the 

name for products related to music. This peace was short lived as Apple Records 

sued Apple Computer in 1989 fro trademark violation, and again in 2003. The 

first instance was settled out of court in 1991, the most recent development re-

mains unresolved. 

The Apple logo design is at once simple and unforgettable. So effective in fact 

that it has remained largely unchanged for 20 years. An apple with a bite taken 

out of it. A universally recognized symbol of knowledge- one that remains em-

phatically so in this knowledge driven age. 

http://en.wikipedia.org/wiki/Apple_Records
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These 2 passages probably come from:  

A: a book.  

B: a brochure.  

C: a web article.  

D: the beginning of a story. 

 

Based on these 2 passages, what might you assume about the apple logo  

A: It was created to represent knowledge.  

B: It was created in France.  

C: It was created with a bite to show scale.  

D: It was created by Steve Jobs. 

 

The author's attitude in the second article does not line up with which idea? 

A: It was created to symbolize knowledge  

B: The wrong order of colors showed freedom 

C: The colors show vibrancy and energy 

D: It was created to show scale  

 

What is the tone of the author in article #2? 

      A: Comical  

B: Aggravated 

C: Sympathetic 

D: Confident 

 

In article #2, what does the word fledgling mean in the first sentence? 

 A: Inexperienced  

B: Failing 

C: Successful 

 D: Complicated  

 

Why does the author of article #1 use first person? 

 A: To show authority 

 B: To show opinion 

C: To show expertise 

 D: To show dislike 
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PROXIMITY 
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Design and Digital Media:  Social Issues Montage 
 

You are going to create a photo montage using at least 5 photos to bring atten-

tion to a social issue you feel needs attention. Some examples of social issues are 

teen pregnancy, drop out rate, teen violence, gun violence, human trafficking, 

drug abuse, alcohol abuse, any time of abuse, unemployment,  

poverty, etc… 

 
 Open a “New” File in Photo Shop 

 File>New, name the document LastnameFirstnameTitleMontage 

 Suggested size is 800X600 Pixels or Letter  

 Resolution:  72 PPI 

 RGB Color 

 White Background 

 Decide on what social issue you want to design a collage for.   

 Think about controversial topics but keep in mind your collage must be school  

 appropriate wording and imagery.  

 Review your toolbox and find your layers menu 

 Hunt for images and photographs you can use for your collage 

  NO copyright logos or drawings 

  Photos must be manipulated if they are used 

  Experiment with filters and the images settings 

 To add an image, open it up in Photoshop, manipulate it and then drag it onto your com-

position.   To resize once moved hit edit>free transform 

 Use your opacity tool and the drop down menu of blending modes to adjust how con-

trasting your layers are and how they blend together.   

 Make sure your “Free Transform controls” is checked 

 Hold shift to keep proportions 

 Hold control to skew 

 Go to the layers tab and choose Layer styles to mess around with these options for layers.  

 Add text using the text tool 

 Use the format tool for drop shadows and other 

 Name each layer 

 Jot down what you do!  You have to remember your settings if you want to repeat it! 

 Use the Eyedropper tool to duplicate color  exactly 

 Use the blur tool or the eraser tool with a fuzzy brush to get r id of hard edges 

 Use filters to make images look interesting and EXPLORE tutor ials and just mess around. 

 Save as a Photoshop file as you go, label properly.   

 End project by saving your design as a Photoshop file and a jpeg file to your drive.   

 

 

REMEMBER:  YOUR DESIGN MUST FLOW AND LOOK UNIFIED! 
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1.  Student paid attention to the demonstration.   4 3 2 1 IE 

2.  Student used a minimum of 4 images plus text.   4 3 2 1 IE 

3.  Student used originality and creativity (no logos).   4 3 2 1 IE 

4.  Photos used are manipulated or taken by the student..  4 3 2 1 IE

  

 

 
 

1.  Photo layers are altered with colors and opacities.   4 3 2 1 IE 

2.  Font is thought out and unified.     4 3 2 1 IE 

3.  Image placement shows a thought out composition.  4 3 2 1 IE 

4.  Balance of items agrees with the composition.   4 3 2 1 IE 

5.  Images and text are used as a team.    4 3 2 1 IE 

 

 
 

1.  New fonts and images are used.         4 3 2 1 IE 

2.  Images are not pixelated.     4 3 2 1 IE 

3.  Construction was completed with little assistance.   4 3 2 1 IE 

4.  Words are edited for spelling.     4 3 2 1 IE 

5.  Colors work well together thinking about color theories.  4 3 2 1 IE 

6.  Project is mounted on black paper.    4 3 2 1 IE 

7.  Finished design shows unity and rhythm.    4 3 2 1 IE

  

  

 
 

1.  Time is used effectively, no goofing off or slacking.  4 3 2 1 IE 

2.  Student self regulated speed of work,  

     finishing on time, name on back in pencil.   4 3 2 1 IE 

3.  Attention given to introduction, demos, and  

     instructions.       4 3   2 1 IE 

4.  Student cleaned up diligently and on time.   4 3 2 1 IE 

 

Score:       /80  

 
Save assignment in a folder called:  Montage 
Jpeg:  LastnameFirstnameTitleMontage  
Photoshop file:  LastnameFirstnameTitleMontagePS 

Design and Digital Media:  Social Issue Montage 

SCORING GUIDE 

Designing the Artwork 

Creating the Artwork 

Getting the Artwork Done 

Class Participation 



35 



36 



37 



38 



39 



40 
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DESIGN CHALLENGE:  MOVING SHAPES! 

Procedure 
1) Using black construction paper, cut out ten triangles, ten circles, and ten 
small squares. Make each shape the same size, 1” or smaller in width. 
2) Within one 6”x 6” piece of yellow paper that acts as your foundation paper, 
create the following solution: using circles, show how the speed can change 
demonstrating slow movement and fast movement in the same space. 
3) Within one 6”x6” piece of orange paper, create the following solution:  
using squares, show how they would look as if they were bouncing in the 
space. 
4) Within one 6”x6” piece of green paper, create the following solution: using 
triangle, show how they would look as if they were flying in and out of the 
space. 
5) Glue them in your art journal on white office paper that is 3 hole punched 
(one 6”x6” square per page). Glue them in this order: Squares, Circles, and 
Triangles. 
6) Label each page with a clear title in all CAPS: circles changing speed, 
squares bouncing in space, triangles flying in and out of space. 

 
HINT: Your shapes may overlap or extend outside the 6”x6” foundation square, but if they do 

extend,  Cut everything off to keep the 6”x6” foundation square. 
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Project requirements and Key Concepts 
Directions are ready fully and carefully.  4 3 2 1 IE  
 
All three foundation papers are cut 6 inches by 6 inches. 4 3 2 1 IE  
Craftsmanship during cutting shows skill use of that tool.   4 3 2 1 IE  
 
All shapes are cut the same size one inch or under.  4 3 2 1 IE  
Craftsmanship during cutting shows skill use of that tool. 4 3 2 1 IE  
 
Finished squares are trimmed to remain 6 inches by 6 inches, no pieces hanging off.   4 3 2 1 IE  
Foundation papers are correct colors (record if using a different color).  4 3 2 1 IE  
 
Three finished squares are glued onto white typing paper.    4 3 2 1 IE  
Holes are punched in the typing paper and papers are bradded into the art folder.   4 3 2 1 IE  
 
Sheets are in the right order.    4 3 2 1 IE  
Pages are labeled as instructed 4 3 2 1 IE  
Craftsmanship of cutting and measuring is high.  4 3 2 1 IE  
 

Presentation and Craftsmanship 
All pieces are securely glued down.  No excess glue is showing.   4 3 2 1 IE  
Overall craftsmanship of the end product shows time was taken/mistakes were corrected.  4 3 2 1 IE  
 
Circles changing speed is illustrated clearly.  4 3 2 1 IE  
Squares bouncing out of space is illustrated clearly.  4 3 2 1 IE  
Triangles flying in and out of space is illustrated clearly.  4 3 2 1 IE  
 

Work habits of an Artist 
Productive no matter how many distractions occur 4 3 2 1 IE  
 
Maintained consistent effort; didn’t rush to finish and paid attention to details 4 3 2 1 IE  
Project is turned in on time.   4 3 2 1 IE  
 

Grade:     /80 
 
 
 

 
 
 

Moving Shapes Challenge #2 
Summative Scoring Guide  

80 points possible 

4 My art skills are refined and polished. I can problem solve and envision the end result before I have begun. 
 I can assist others and help them critically think through a challenge. 

3 I have quality art skills. I can use them without help. I am capable and in control of those skills, and know what  
techniques to use in a given situation. 

2 Basic art skills are part of me as long as I have assistance along the way. I need guidance and support to finish.  
I know what to do, but need help. 

1 I participate in the process and understand the various techniques. I can only finish a project as long as others guide me through every 
step. 

IE Insufficient evidence:  Even with help, no understanding or skill demonstrated  
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Handbook Cover Design Contest 

 
You are required to submit a design to be judged for next year’s student handbook  

cover.  The judging will be completed by your student body and teachers.  Below are 

the guidelines for the project.   

 

 1.  Open a new file in Photo Shop 

 Set the Width to 5.75 

 Set the Height to 8.75 

 300 pixels per inch 

 Cmyk Color Option 

2.   Use fonts, images and Photo Shop tools to create an interesting and engaging 

composition that represents Ray Pec and the student body. 

3.   Use photos and logos that are school related.  You may only use items from 

the internet as a point of departure, images must be altered heavily.   

4.   Make sure you take into consideration that the actual image size on the cover 

will be 5.5 X 8.5.  The extra space allows the image to “bleed”.  Keep important 

text and images within the actual image size.  A suggested 1/2 in border on all 

sizes is recommended.   

5.   There will be a binding on the either side of the image.  Keep that in mind as 

well, up to .5 inches will be binding punched. 

6.   See artpugh.weebly.com for a link to approved school logos.   If you use 

photographs other students have taken you must show written permission to use 

their photos.   

7.   Save your image as both a JPEG file and a Photo Shop file on your shared 

drive.  You must also print out two copies of the image actual size of your cover.  

PRIZE 

MONEY!!! 

 

1st:  $75 

 

2nd:  $50 
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1.  Student paid attention to the demonstration   4 3 2 1 IE 

2.  Student researched related content to use    4 3 2 1 IE 

3.  Student used photo shop to complete the project   4 3 2 1 IE  

4.  Student shows creative thinking skills     4 3 2 1 IE  

 

 
 

1.  Fonts show creativity      4 3 2 1 IE 

2.  Color is used to enhance the work    4 3 2 1 IE 

3.  Words used show variety and relate to the subject.   4 3 2 1 IE 

4.  Words fill the space with repetition and varied sizes.   4 3 2 1 IE  

5.  Image and text are used as a team    4 3 2 1 IE 

 

 
 

1.  Copyright images are not used.         4 3 2 1 IE 

2.  Photo shop skills are improved upon    4 3 2 1 IE 

3.  Finished projects shows creative solutions   4 3 2 1 IE 

4.  Image is Printed off full size in color    4 3 2 1 IE 

5.  Directions are followed, size is correct    4 3 2 1 IE 

6.  Final jpeg and PS file are saved to google drive   4 3 2 1 IE  

  

 
 

1.  Copyright quiz is completed.     4 3 2 1 IE 

2.  Student self regulated speed of work,  

     finishing on time, name on back in pencil.   4 3 2 1 IE 

3.  Attention given to introduction, demos, and  

     instructions.       4 3   2 1 IE 

4. Student cleaned up diligently and on time.   4 3 2 1 IE 

5. Project is labeled correctly and save on the drive.   4 3 2 1 IE 

 

Grade ______/80 
 

Save assignments in a folder called:  Cover Design 
Jpeg:  LastnameFirstnameTitleCover 
Photoshop file:  LastnameFirstnameTitleCoverPS 

Design and Digital Media   

Student Handbook Cover Design 

Designing the Artwork 

Creating the Artwork 

Getting the Artwork Done 

Class Participation 
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Design and Digital Media:  Typography Color Collage 

 

Summary:  Using Typography as a basis for a design collage, students create a 

successful composition using different fonts of one letter in a thought out overlapping 

composition and paint it using a chosen color scheme.   

 

Key Idea:  Typography exists all around us and explor ing the different types and 

fonts gives an overview of the variety of letters available to use.  Using thought out 

color schemes can draw the viewers eye around an artwork.   

 

Objectives:  Students will… 

Choose a letter of the alphabet. 

Use books and the computer to print off letters in a variety of sizes and fonts . 

Make a one inch border in pencil lightly on the provided drawing paper.  

Use a variety of transfer techniques including stencils, light boxes, and graphite 

paper to arrange a composition of overlapping letters.  

Choose a color scheme to use, remember you can use neutral colors with any color 

scheme and all the tints and shades of the colors in that scheme.   Write the 

scheme, definition and colors used on the back of the project.   

Divide the collage into 3 sections. 

 The two outer sections should be one color scheme and the middle section 

should be a different color scheme.  

Use your markers carefully, adding more layers to hide the streaks.   

Remember that dark colors over power and to use both light and dark….focusing 

on light sections to help balance the artwork.   
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Points Possible:  76 

 
 

1.  Student paid attention to the demonstration   4 3 2 1 IE 

2.  Student researched a variety of fonts    4 3 2 1 IE 

3.  Student used a variety of transfer methods   4 3 2 1 IE  

4.  Student shows creative thinking skills     4 3 2 1 IE  

  

 
 

1.  Fonts show creativity and variety    4 3 2 1 IE 

2.  Collage shows balance      4 3 2 1 IE 

3.  Letters overlap and fill the space nicely.     4 3 2 1 IE 

4.  Student simplifies complicated spaces by erasing   4 3 2 1 IE  

5.  Color schemes are chosen and written on the back   4 3 2 1 IE 

 

 
 

1.  Student uses the medium with high craftsmanship.      4 3 2 1 IE 

2.  Layers of medium are hidden.     4 3 2 1 IE 

3.  Finished projects shows creative solutions   4 3 2 1 IE 

4.  Craftsmanship shows high skill level    4 3 2 1 IE 

5.  Composition is divided into 3 sections    4 3 2 1 IE 

6.  Tints and shades are used with the color theory.   4 3 2 1 IE  

   

 
 

1.  Time is used effectively, no goofing off or slacking.  4 3 2 1 IE 

2.  Student self regulated speed of work,  

     finishing on time, name on back in pencil.   4 3 2 1 IE 

3.  Attention given to introduction, demos, and  

     instructions.       4 3   2 1 IE 

4. Student cleaned up diligently and on time.   4 3 2 1 IE 

 

Grade ______________/76 

 

Design and Digital Media:  Typography Color Collage 

SCORING GUIDE 

Designing the Artwork 

Creating the Artwork 

Getting the Artwork Done 

Class Participation 
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Design and Digital Media:  Illustrator Gone Wild 

 

1. Open a new file 

2. Choose Letter Size and RGB color 

3. Use a line drawing type image from the internet (cartoons, not logos) 

4. Copy the image from the internet and paste it onto your Illustrator 

document.  Lock this layer to prevent yourself from typing on top of 

the original image.   

5. Create a new Layer (bottom of layer menu) SUPER IMPORTANT 

6. Get the ellipse tool by holding down on the square in the toolbox and 

selecting the oval 

7. Hold down on the text tool and select the one that looks like a tilted 

T.  This will allow the text to follow the curves of your oval you 

have placed. 

8. Decide on colors and fonts to make your image convincing and      

interesting. 

9. You can use control copy paste to repeat text you have already done 

to quickly fill areas. 

10.To see how your text is looking, click on the eye next to Layer 1 and 

your image will disappear allowing you to only look at the text. 

11.You can experiment with the pen tool and other paths plus reflection.  
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1.  Student paid attention to the demonstration   4 3 2 1 IE 

2.  Student found an appropriate line drawing   4 3 2 1 IE 

3.  Student used illustrator to complete the project   4 3 2 1 IE  

4.  Student shows creative thinking skills     4 3 2 1 IE  

 

 
 

1.  Fonts show creativity and fill up the positive space.  4 3 2 1 IE 

2.  Color is used to enhance the work    4 3 2 1 IE 

3.  Words relate to the image and show variety.   4 3 2 1 IE 

4.  Composition shows a nice use of space    4 3 2 1 IE  

5.  Image and text are used as a team    4 3 2 1 IE 

 

 
 

1.  End result looks like the image        4 3 2 1 IE 

2.  Illustrator skills are learned     4 3 2 1 IE 

3.  Finished projects shows creative solutions   4 3 2 1 IE 

4.  Image is Printed off full page in color    4 3 2 1 IE 

5.  Directions are followed      4 3 2 1 IE 

6.  Nice craftsmanship is used     4 3 2 1 IE  

  

 
 

1.  Time is used effectively, no goofing off or slacking.  4 3 2 1 IE 

2.  Student self regulated speed of work,  

     finishing on time, name on back in pencil.   4 3 2 1 IE 

3.  Attention given to introduction, demos, and  

     instructions.       4 3   2 1 IE 

4. Student cleaned up diligently and on time.   4 3 2 1 IE 

5. Files are saved and labeled correctly on the drive.  4 3 2 1 IE 

 

Grade:  _______/80 
 
Save assignments in a folder called:  GoneWild 
Jpeg:  LastnameFirstnameTitleGonewild 
Photoshop file:  LastnameFirstnameTitleGoneWildPS 

Design and Digital Media:  Illustrator Gone Wild 

SCORING GUIDE 

Designing the Artwork 

Creating the Artwork 

Getting the Artwork Done 

Class Participation 
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1. Do one of the following:  

 To create horizontal text along a path, select the Type tool  or the Type On A Path tool . 

 To create vertical text along a path, select the Vertical type tool  or the Vertical Type On A 

Path tool . 

 (Optional) Set text-formatting options in the Control panel, Character panel, or Paragraph panel. 

 Position the pointer on the path, and click. (It doesn’t matter if the path has stroke or fill attributes, because Illus-
trator automatically removes them.)  

  

 Enter the text. 

Note: If the path is closed, rather than open, you must use the Type On A 

 

1. Select the path type object. 

2. A bracket appears at the beginning of the type, at the end of the path, and at the 
midpoint between the start and end brackets. 

3. Position the pointer over the type’s center bracket until a small icon appears next to the pointer 
. 

4. Do one of the following:  

 To move text along the path, drag the center bracket along the path. Hold down 
Ctrl (Windows) or Command (Mac OS) to prevent the type from flipping to the other 
side of the path. 

  

 To flip the direction of text along a path, drag the bracket across the path. Alter-
natively, choose Type > Type On A Path > Type On A Path Options, select Flip, and 
click OK. 
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1. Select the path type object. 

2. Do one of the following:  

 Choose Type > Type On A Path and select an effect from the submenu. 

  

 

Choose Type > Type On A Path > Type On A Path Options. Then select an option from the Effect 

 

Path type effects:   

A– Rainbow  

B-Skew 

 C-3D ribbon 

 D-Stair step 

E-Gravity 

 
1. Select the type object. 

2. Choose Type > Type On A Path > Type On A Path Options. 

3. For Spacing, type a value in points. Higher values remove the extra space from between characters 
positioned on sharp curves or angles 

When characters flow around a sharp curve or acute angle, they fan out in such a way 
that there may appear to be extra space between them. You can tighten the spacing of 
characters on curves using the Spacing option in the Type On A Path Options dialog 
box. 
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DESIGN CHALLENGE:  STIPPLING A SKULL 

 
1. Use the provided paper that is 8.5 X 11 or find a creative paper type to draw on 

such as music sheets, wall paper, news paper or magazine page in that same 

size. 

2. Choose a skull to draw.  You may use a human or animal skull.  Print this im-

age off as a full page.  You have to use an actual photograph of a skull, no 

drawings or cartoons.   

3. Use a light box to transfer the outline of your skull to the paper in pencil.   

4. Using the original photograph as a reference, create a value study of the skull 

using the stippling drawing technique with fine line sharpie thinking about   

visual wieght. 

5. Upon completion, lightly erase the original outline that was done in pencil.  

6. When done, take a photograph of your artwork and load it into Photoshop.   

7. Use Photoshop filters and other tools to add a creative twist to your artwork.   

8. Print this new artwork out full page.   

9. Mount both the original drawing and the Photoshop version to black paper.   

You can mount them separately or together.  Think about craftsmanship.  
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Project requirements and Key Concepts 
Directions are ready fully and carefully.  4 3 2 1 IE 
A photograph of a skull, human or animal, is used. 4 3 2 1 IE  
Initial drawing of contour takes up a large amount of space on the paper.   4 3 2 1 IE  
 
Initial drawing of contours is done in pencil, with corrections made as the artist draws.  4 3 2 1 IE  
Contour outlines show a close likeness to the original item.   4 3 2 1 IE  
 
Initial contours are NOT outlined, rather stippled in as the drawing is worked through.  4 3 2 1 IE 
Stippling is done in fine line sharpie.   4 3 2 1 IE  
 
Stippling follows the original value intensities. . 4 3 2 1 IE  
Stippling fills the space, artist uses an amount that makes the drawing have weight. 4 3 2 1  IE 
More dots are added for darker values. 4 3 2 1  IE 
There are only a few highlighted areas that have zero dots.  4 3 2 1 IE 
 
Original artwork is photographed to create a digital version.   4 3 2 1 IE 
Digital artwork is altered in Photoshop with filters or tools. 4 3 2 1 IE  
 
Artist signed the back of the artwork in pencil.    4 3 2 1 IE  
 

Presentation and Craftsmanship 
Completed artwork shows a successful design creation of the original skull.   4 3 2 1 IE  
Overall craftsmanship of the end product shows time was taken/mistakes were corrected.  4 3 2 1 IE 
Both artworks are mounted on black paper. 4 3 2 1 IE 
 
 

Work habits of an Artist 
Productive no matter how many distractions occur 4 3 2 1 IE  
Instructions were carefully followed.   4 3 2 1 IE  
Maintained consistent effort; didn’t rush to finish and paid attention to details 4 3 2 1 IE  
Project is turned in on time.   4 3 2 1 IE 
Photoshop version is correctly labeled and saved on the drive. 4 3 2 1 IE   
 

Grade:     /88 
 
 
 

Save your computer version in a folder labeled:  Skulls 
Jpeg:  LastnameFirstnameTitleSkull 
Photoshop file:  LastnameFirstnameTitleSkullPS 
 
 

DESIGN CHALLENGE:  STIPPLING A SKULL 
68 points possible 

 

4 My art skills are refined and polished. I can problem solve and envision the end result before I have begun. 
 I can assist others and help them critically think through a challenge. 

3 I have quality art skills. I can use them without help. I am capable and in control of those skills, and know what  
techniques to use in a given situation. 

2 Basic art skills are part of me as long as I have assistance along the way. I need guidance and support to finish.  
I know what to do, but need help. 

1 I participate in the process and understand the various techniques. I can only finish a project as long as others guide me through every 
step. 
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Design and Digital Media   

Geometric Animals 

 
Summary:  Using a photograph of an actual animal, students use a wet on 

wet watercolor background and geometric line drawings to complete a creative 

drawing solution of the animal.   

   

Key Idea:  Ar tist can use geometr ic lines to fill the space of an animal     

drawing and still give the illusion of visual weight by increasing the lines for the 

darker values.      

    

Objectives:  Students will… 

Choose an animal that interests you and print off an ACTUAL photograph    

(no drawings/cartoons or outlines) full page. 

Use liquid water color paint and a wet on wet technique to create a geometric 

shape (or shapes) on the paper provided to you.  Make a few to choose 

from.   

After the watercolor has dried, use a transfer method to outline your animal 

and important inner detail on top of the geometric shape.  .   

Use varied weight and geometric lines to fill the positive space of the animal.  

The lines should be more repetitive or thicker to represent darker values.    

You may draw in details like eyes, noses, horns as you decide (real or            

geometric in style).   

Clean up any stray pencil marks.   

   

Missouri State Standards:  F1, F2, F3 

Gle’s:  Strand I 1A HS Level 1            

Strand II 1D HS Level 2  S 

trand II 2C HS level 2 
Materials:  Water Color paint, water   

Color paper, brushes, sharpies and internet.   

Resources:   Lesson plan, internet, examples 
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1.  Student paid attention to the demonstration   4 3 2 1 IE 

2.  Student researched an animal that interest them, actual photo used.  4 3 2 1 IE 

3.  Watercolor Geometric shape is painted using wet on wet tech. 4 3 2 1 IE  

4.  Wet on Wet technique shows experimentation and perfecting. 4 3 2 1 IE  

 

 
 

1.  Animal is successfully transferred to watercolor paper.  4 3 2 1 IE 

2.  Outline and important inner details are proportional.   4 3 2 1 IE 

3.  Positive space is divided up for the geometric line design.  4 3 2 1 IE 

4.  Ruler is used to draw lines straight in sharpie.     4 3 2 1 IE  

5.  Weight is show through thicker lines and increased quantity of lines 4 3 2 1 IE 

6. Weight matches the value of photo of the animal.   4 3 2 1 IE 

 

 
 

1.  Project shows it was not rushed        4 3 2 1 IE 

2.  Stray pencil marks are erased.     4 3 2 1 IE 

3.  Paint is neatly applied.      4 3 2 1 IE 

4.  Craftsmanship shows a high skill level    4 3 2 1 IE 

5.  End product paper is not folder, bent or torn.   4 3 2 1 IE 

    

   

 
 

1.  Time is used effectively, no goofing off or slacking.  4 3 2 1 IE 

2.  Student self regulated speed of work,  

     finishing on time, name on back in pencil.   4 3 2 1 IE 

3.  Attention given to introduction, demos, and  

     instructions.       4 3   2 1 IE 

4.  Student cleaned up diligently and on time.   4 3 2 1 IE 

 

Points Possible:    /76 
 
 

Design and Digital Media:  Geometric Animals 

SCORING GUIDE 

Designing the Artwork 

Creating the Artwork 

Getting the Artwork Done 

Class Participation 
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Design and Digital Media 

City Silhouettes 
 

Summary:  Using the images of a par ticular  city, silhouettes are created and 

put together to create an interesting composition of thought out color and space.   

   

Key Idea:  Silhouettes can take a complicated subject matter and simplify it 

while maintaining its ability to be recognized.  Designers can use silhouettes to 

represent objects in a new way that is interesting and captivating to their audience.      

    

Objectives:  Students will… 

Choose a city that has many items representing it. 

Use the internet to research and collect images that represent that city.  Save 

the files as jpegs. 

Start in Photoshop with an 18X24 inch size canvas with 300 resolution.   

Use the various images found to make silhouettes using the magic wand tool 

and fill tool.   

Fill the silhouettes using a thought out color scheme of 3 colors.  Any tints or 

shades of those colors can be used in the collage. 

  ***  Create a new layer 

   Use the magnetic lasso tool, select around the wanted area 

   Select “Inverse” 

   Delete and recolor with any solid color besides white 

   Sect “Inverse” 

   Delete and recolor whatever you want your silhouette to be 

   Recolor background to white 

    

Include the name of the city creatively, 

think about how to blend it into the 

background or build it into the com-

position.   

Analyze the artwork to make corrections 

before turning it in. 

 

Missouri State Standards:  F1, F2, F3 

Gle’s:  Strand I 1A HS Level 1            

Strand II 1D HS Level 2  S 

trand II 2C HS level 2 
Materials:  Computers, Photo Shop 

Resources:   Lesson plan, internet,        

examples 
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1.  Student paid attention to the demonstration   4 3 2 1 IE 

2.  Student researched a city and its symbols    4 3 2 1 IE 

3.  Photo Shop was used to complete the project   4 3 2 1 IE  

4.  A color scheme is chosen:  write it here ____________________ 4 3 2 1 IE  

 

 
 

1.  Designs show creativity     4 3 2 1 IE 

2.  Designs show variety of at least 5 city items.     4 3 2 1 IE 

3.  Silhouettes are recognizable and do not “float”   4 3 2 1 IE 

4.  The city is represented clearly      4 3 2 1 IE  

5.  Name of the city is included     4 3 2 1 IE 

6. Name of the city is blended into the composition   4 3 2 1 IE 

7. Images are not pixelated     4 3 2 1 IE 

 

 
 

1.  Project shows it was not rushed        4 3 2 1 IE 

2.  Colors fit the tints, shades and hues of the scheme   4 3 2 1 IE 

3.  Items work together as a whole in a successful composition  4 3 2 1 IE 

4.  Craftsmanship shows a high skill level    4 3 2 1 IE 

5.  Silhouettes overlap properly, depth is understandable  4 3 2 1 IE 

    

   

 
 

1.  Time is used effectively, no goofing off or slacking.  4 3 2 1 IE 

2.  Student self regulated speed of work,  

     finishing on time, name on back in pencil.   4 3 2 1 IE 

3.  Attention given to introduction, demos, and  

     instructions.       4 3   2 1 IE 

4.  Student cleaned up diligently and on time.   4 3 2 1 IE 

5.  Photoshop file and Jpeg file are saved to the drive.   4 3 2 1 IE 

 

 

Points Possible:    /84 
 
Save assignments in a folder called:  Silhouette 
Jpeg:  LastnameFirstnameTitleSilhouette 
Photoshop file:  LastnameFirstnameTitleSilhouttePS 

Design and Digital Media:  City Silhouettes 

SCORING GUIDE 

Designing the Artwork 

Creating the Artwork 

Getting the Artwork Done 

Class Participation 

CITY RESEARCH:

 

List 5 landmarks that represent 

your city: 

1. 

2.  

3. 

4. 

5. 
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Communication Arts:  Design Portrait 

Final Photoshop Study 
 

Summary:  Using typography and a por trait, create an expressive Photoshop 

product that reveals your subject’s personality. 

 

Key Idea:  Text can be used to express personality about someone.  Photoshop 

can be used to alter a portrait photograph into an artwork that screams about who a 

person is.   

 

Objectives:  Students will… 

 Take a portrait of someone to use for this project or use a photograph of a famous 

person from the internet.   

 Upload the photo into Photoshop and follow the tutorial to create their project. 
 https://www.youtube.com/watch?v=UtbzpunD4Rc 

 http://10steps.sg/tutorials/photoshop/make-yourself-an-amazing-typographic-portrait/ 

 http://layersmagazine.com/photoshop-cs4-a-picture-worth-a-thousand-words.html 

 Text used should describe the subject.   

 Experiment with composition, backgrounds, brushes and color to create their best 

artwork of the semester.   

 Print out portrait full page. 

 Mount project to black paper.   

 

Missouri State Standards:  F1, F2, F3 

Gle’s:  Strand I 1A HS Level 1           Strand II 1D HS Level 2  Strand II 2C HS level 2 

Materials:  Photoshop, tutor ials, paper, pr inter  

Resources:   Lesson plan, internet, books 

http://10steps.sg/tutorials/photoshop/make-yourself-an-amazing-typographic-portrait/
http://layersmagazine.com/photoshop-cs4-a-picture-worth-a-thousand-words.html
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1.  Student looked at examples so they clearly understood the project. 4 3 2 1 IE 

2.  Student used a photo as reference with solid background.   4 3 2 1 IE 

3.  Portrait is of someone they know well or a famous person.  4 3 2 1 IE  

4.  Words are brainstormed that describe their subject.  4 3 2 1 IE  

 

 
 

1.  Designs show creativity with font    4 3 2 1 IE 

2.  Designs show variety of fonts used.    4 3 2 1 IE 

3.  Image shows color changes or value changes.   4 3 2 1 IE 

4.  Composition is taken up largely by the portrait.     4 3 2 1 IE  

5.  Words come to life with movement from the subject.  4 3 2 1 IE 

6.  Project shows time taken to perfect the final image.   4 3 2 1 IE 

 

 
 

1.  Project was not rushed.         4 3 2 1 IE 

2.  Words are appropriate and spelled correctly.   4 3 2 1 IE 

3.  Finished projects shows creative solutions   4 3 2 1 IE 

4.  Craftsmanship shows high skill level    4 3 2 1 IE 

5.  Project is printed full page and mounted to black paper.  4 3 2 1 IE 

    

   

 
 

1.  Time is used effectively, no goofing off or slacking.  4 3 2 1 IE 

2.  Student self regulated speed of work,  

     finishing on time, name on back in pencil.   4 3 2 1 IE 

3.  Attention given to introduction, demos, and  

     instructions.       4 3   2 1 IE 

4. Student cleaned up diligently and on time.   4 3 2 1 IE 

5. Files are labeled correctly and saved to the drive.   4 3 2 1 IE 

 

Points Possible:    /80 
 

Save assignments in a folder called:  Design Portrait 
Jpeg:  LastnameFirstnameTitlePortrait 
Photoshop file:  LastnameFirstnameTitlePortraitPS 
 

This score will be combined with your written final!   

Design and Digital Media:  Design Portrait 

SCORING GUIDE 

Designing the Artwork 

Creating the Artwork 

Getting the Artwork Done 

Class Participation 


